# Table of Contents

## Installing ABBYY FlexiCapture 9.0
- Standalone Installation ........................................................................................................ 4
- Distributed Installation ........................................................................................................ 4
  - Preparing the Application Server ..................................................................................... 4
  - Installing the servers ........................................................................................................ 8
  - Installing the stations ......................................................................................................... 9
- Using Active Directory ....................................................................................................... 10
  - Example: Deploying ABBYY FlexiCapture 9.0 using Active Directory ......................... 11
- Using SMS .......................................................................................................................... 14
  - Example: Deploying ABBYY FlexiCapture 9.0 using Microsoft SMS .............................. 14
- Installing a Remote Stations .............................................................................................. 17

## Managing Your Licenses
- Overview .......................................................................................................................... 18
- ABBYY FlexiCapture 9.0 License Manager ........................................................................ 18
- License properties ............................................................................................................. 19
- License statuses ............................................................................................................... 20
  - How activation is carried out? ......................................................................................... 21
- Buttons in the License window ......................................................................................... 20
- Activating a license ............................................................................................................ 21
- Connecting stations to the Protection Server .................................................................... 22

## Setting Up FlexiCapture 9.0 Distributed Installation
- Setting up the system ....................................................................................................... 24
- Setting up Microsoft Internet Information Server (IIS) ..................................................... 26
  - Checking the operation of IIS ......................................................................................... 26
  - Setting Up IIS ................................................................................................................. 27
- Security settings ............................................................................................................... 30
  - Major scenario ............................................................................................................... 30
  - Some of the stations are not in the domain ...................................................................... 31
  - Work group .................................................................................................................... 31
  - Without authorization ...................................................................................................... 32
- Database settings ............................................................................................................. 32

## Logging
- Administration and Monitoring Console logs ................................................................. 33
- Task processing logs on the Processing Servers .............................................................. 33
- OS event logs on the servers .......................................................................................... 33

## Technical Support
© 2009 ABBYY. All rights reserved.
Installing ABBYY FlexiCapture 9.0

Before purchasing the product, analyze your document processing needs and select either the local or the distributed version.
If you plan to process moderate amounts of documents (approximately 5,000 pages per day), employ one or two operators for the job, and do not require any sophisticated batch routing, then Local Installation is the best choice.
If you plan to automate data capture and processing, require sophisticated batch routing based on document or batch types, and need a scalable pool of centrally administered workstations, then select Distributed Installation.

Important! The distributed and local versions cannot be installed on the same computer.

Standalone Installation
To install the standalone version of ABBYY FlexiCapture:

1. Place the ABBYY FlexiCapture 9.0 CD-ROM into the CD-ROM drive.
2. In the Autorun menu, select Standalone Installation (or run the setup.exe file located on the CD-ROM).
3. Select a setup language. The setup program will compare the locale of your system and the selected language. If the languages are incompatible, a warning message is displayed.
4. Next, the setup program checks the version of your operating system and the availability of the administrative permissions. If the version of the operating system is not supported by the program or you do not have the administrative permissions, a warning message is displayed and the setup program is terminated.
5. If all the checks are passed successfully, the end-user license agreement will be displayed. Read the license agreement carefully and if you agree with the terms of the agreement, select the corresponding option and click Next.
6. A dialog box will open prompting you to enter some information about yourself. Enter the required information and continue with the installation.
7. In the next dialog box, select one of the available installation modes: Administrator Station – The setup program installs the Administrator Station, FormDesigner 9.0, and FlexiLayout Studio 9.0.
Operator Station – The setup program installs only the Operator Station. (The Administrator Station, FormDesigner 9.0 and FlexiLayout Studio 9.0 will not be installed).
8. Next, select a destination folder. By default, the program is installed to %Program Files%\ABBYY FlexiCapture 9.0. If there is not enough space on the selected hard disk, a window is displayed showing your hard disks, the available free space, and the space required by the installation. Select a disk with sufficient free space and continue with the installation.
9. The program files will be copied onto your computer. Once the installation is finished, the setup program will display a message saying that the application has been successfully installed.
10. FlexiCapture 9.0 License Manager will be launched automatically so that you can activate your serial number. See the Managing Licenses section for details.

Notes.
1. The system can be installed on a workstation in one mode only: as the Administrator's station with additional tools or as the Operator's station.
2. For information about configuring multiple workstations to work with a single license server, see “Connecting stations to the Protection Server”.

Distributed Installation
The following three steps are required to install the distributed version of ABBYY FlexiCapture:

1. Prepare the Application Server.
2. Install the servers.
3. Install the workstations.

Preparing the Application Server
The distributed version of FlexiCapture 9.0 includes three servers:
Application Server
Protection Server
The Application Server coordinates the work of the stations ensures the correct operation of ABBYY FlexiCapture 9.0. The following components must be installed on your computer before you can install the Application Server:

Net Framework 2.0 or later

This component, together with a number of other components, can be installed by selecting Install External Components in the Autorun menu.

IIS (Internet Information Services)

Several IIS versions are available:

- 5.1 for Windows XP
- 6.0 for Windows 2003
- 7.0 for Windows Vista & 2008

Windows XP and Windows Vista are not server operating systems. They support only a limited number of connections and are not very suitable for server use. For the Application Server, Windows 2003 in conjunction with IIS 6.0 is recommended.

To install IIS, select Add or Remove Programs → Add/Remove Windows Components.
During installation, Windows may require files from the setup disk, therefore be sure to have the Windows disk ready at hand. If you install the Application Server on Windows Vista or Windows 2008 (IIS 7.0), select the following additional IIS components:

- Web Management Tools
- IIS 6 Management Compatibility
- IIS 6 Metabase and IIS 6 configuration compatibility
- IIS 6 Scripting Tools
- World Wide Web Services
- Application Development Features
  - ASP.NET
  - ISAPI Extensions
- Common HTTP Features
  - Static Content
- Security
- Windows Authentication

If any of the components is missing on your computer, the setup program will display a warning message and the installation of the Application Server will stop.

Once the installation is complete, open the Administrator Console and make sure that the IIS service is running.

**Important!** In Windows 2003 ASP.NET is disable by default for security reasons. This will cause “Error 404 File not found” when you attempt to start the Monitoring Station. To solve the problem, allow the ASP.NET v2.0 service extension in the IIS Manager:

1. Execute the following command from the command line:
   ```vbs
   cscript C:\Inetpub\AdminScripts\adsutil.vbs set W3SVC/AppPools/Enable32BitAppOnWin64 true
   ```
2. Make sure that the World Wide Web Publishing service is running in 32-bit mode.
6. Execute the following command from the command line:
   
   ```bash
   C:\Windows\Microsoft.NET\Framework\v2.0.50727\asnet_regiis.exe -i
   ```

7. The list of IIS service extensions (see below) will now include an entry for the 32-bit version of ASP.Net. Change its status to allowed:

   ![Web Service Extensions](image)

   The following components are required for the correct operation of the system

   The Application Server requires MS SQL Server 2005 or 2008. Mixed Mode must be enabled ("SQL server and Windows authentication") for authentication purposes.

   The ABBYY FlexiCapture 9.0 disk includes MS SQL Server 2005 Express, which can be used for demonstration purposes and for smaller projects, as it limits the size of the database to 4 GB.

   If MS SQL Server 2005 or 2008 is already installed on your computer, you can use the installed version.

   Crystal Reports

   This component is used by the Administration and Monitoring Console to print out reports. Crystal Reports can be installed on the same computer where the Application Server is installed. Without this component, you will not be able to print out reports. However, all other Application Server management functionality will be available.
Important! Before installation, make sure that the Microsoft Distributed Transaction Coordinator runs under the account NT AUTHORITY\NetworkService:

Installing the servers

Once you have made the preparations for installing the Application Server, install the servers.

By default, all servers are installed on the same computer. However, you can install them on different computers by disabling the redundant servers in the setup program.

To install the ABBYY FlexiCapture servers:

1. In the Autorun menu, select Distributed Installation. Next, select Install Servers to start the installation.
2. Select a setup language. The setup program will compare the locale of your system and the selected language. If the languages are incompatible, a warning message is displayed.
3. Next, the setup program checks the version of your operating system and the availability of the administrative permissions. If the version of the operating system is not supported by the program or you do not have the administrative permissions, a warning message is displayed and the setup program is terminated.
4. If all the checks are passed successfully, the end-user license agreement will be displayed. Read the license agreement carefully and if you agree with the terms of the agreement, select the corresponding option and click Next.
5. A dialog box will open prompting you to enter some information about yourself. Enter the required information and continue with the installation.
6. Next, select a destination folder. By default, the program is installed to: %\Program Files\ABBYY FlexiCapture 9.0 Servers
7. Select the servers to install:
   - **Processing Server** – the server that controls the operation of the Processing Stations
   - **Protection Server** – the server that stores and manages licenses. When you install stations, you must specify the address of the Protection Server in the format server, without \\.
   - **Application Server** – the server that controls the operation of the other components
   - **Stations Installer** – selecting this option will copy the stations' setup files onto the Application Server so that you can then deploy them from the server. SMS and Active Directory deployment are supported. Once you select this component, you can specify the destination folder where to copy the setup files.
8. Next the setup program will check if Net Framework 2.0 and IIS are installed on your computer.
9. If any of the components is missing on your computer, the setup program will display a warning message.
10. The program files will be copied onto your computer. Once the installation is finished, the setup program will display a message saying that the application has been successfully installed.

11. Once the installation is complete, FlexiCapture 9.0 License Manager will be launched automatically so that you can activate your serial number. See Managing Your Licenses section for details. The Monitoring Station will also be launched, where you can set up the installed Application Server.

12. Reboot your system for the changes you have made to the IIS settings to take effect.

**IMPORTANT!** The Application Server should be published to the Internet if you wish to use the remote stations over the Internet.

### Installing the stations

The following installation methods are available to install the stations:

- manually (interactive installation)
- from the command line
- using Active Directory
- using Microsoft Systems Management Server (SMS)

The automated installation methods give you speed and flexibility when installing ABBYY FlexiCapture 9.0 on a local area network, as you do not have to install the program manually on each individual workstation.

#### Manual (interactive) installation

To install ABBYY FlexiCapture stations:

1. Install the ABBYY FlexiCapture CD-ROM into the CD-ROM drive.
2. In the Autorun menu, select **Distributed Installation**.
3. Select **Install Workstations** to start the installation.
4. Select a setup language. The setup program will compare the locale of your system and the selected language. If the languages are incompatible, a warning message is displayed.
5. Next, the setup program checks the version of your operating system and the availability of the administrative permissions. If the version of the operating system is not supported by the program or you do not have the administrative permissions, a warning message is displayed and the setup program is terminated.
6. If all the checks are passed successfully, the end-user license agreement will be displayed. Read the license agreement carefully and if you agree with the terms of the agreement, select the corresponding option and click **Next**.
7. A dialog box will open prompting you to enter some information about yourself. Enter the required information and continue with the installation.
8. Next, select a destination folder. By default, the program is installed to: \%\Program Files\ABBYY FlexiCapture 9.0 Stations
9. In the next dialog box, provide the address of the Protection Server. The Protection Server is installed via server installation. The address should not contain slashes, for example: MainServer
10. Select the stations to install:
    - **Scanning Station** scans documents and sends them to the server for further processing
    - **Processing Station** automatically recognizes, imports, and exports documents, controlled by the Processing Server
    - **Project Setup Station** is used to set up projects on the server
    - **Data Verification Station** is used to verify data
    - **Verification Station** is used to verify data, correct document assembly errors, handle exceptions
    - **FlexiCapture Studio** is a tool for creating FlexiLayouts
    - **FormDesigner** is a tool for creating forms

    Just like the servers, the stations can be installed on the same or on different computers.

11. If a Processing Station is selected, a dialog box will appear where you must select the account under which the Processing Station service will run. By default, the service runs under the user NETWORK SERVICE. If you plan to import/export data on this station from/to a storage location with restricted user rights, or if this station is not in the domain, you can specify the user that has the appropriate rights. In this case, the Processing Station service will run under this user.

12. The program files will be copied onto your computer. Once the installation is finished, the setup program will display a message saying that the application has been successfully installed.
Command line installation
In the default configuration, all recognition languages are installed on the local computer and the interface language is selected automatically based on the regional settings of the computer on which the program is installed. All stations are installed, and the network name of the computer from which the setup program is run is used as the Protection Server (in the case of standalone installation, localhost is specified). The default user becomes the user of the Processing Station.

Run the setup.exe file located in the administrative installation folder using the command line options described below.

Advertise installation
For advertise installation, type
Setup.exe /j
The program icon will appear in the Start menu of the workstation. Clicking this icon automatically installs the program in default configuration.

Silent installation
In the case of silent installation, no setup dialog boxes are displayed and the program is installed in default configuration.
Setup.exe /qn
Change “/qn” to “/qb” if you want an installation progress bar to be displayed.
No other dialog boxes will be displayed.

Additional command line options
/L<language code> disables auto selection of the interface language and installs the program with the interface language you specified.
The following language code values are available:

- 1033 English
- 1049 Russian
- 1031 German
- 1036 French
- 2052 Chinese simplified
- 1040 Italian
- 1034 Spanish
/LV <command line> passes the specified command line directly to msiexec.exe. The <command line> string can be replaced with the following commands:

INSTALLDIR=\<destination> – the path to the folder where ABBYY FlexiCapture 9.0 is to be installed.
STATIONS=0,1,2,3,4,5,6 – the list of stations to install.
The numbers 0 to 6 correspond to the following stations:
0 – Scanning Station
1 – Processing Station
2 – Verification Station
3 – Data Verification Station
4 – Project Setup Station
5 - FlexiLayout Studio
6 - FormDesigner
ACCOUNTTYPE=Custom, LOGIN=user name, PASSWORD=password
You can specify an account under which to run the Processing Station service.
Example:
Setup.exe /qn /L1049 /V INSTALLDIR="D:\FC90" STATIONS=1,4 ACCOUNTTYPE=Custom

Removing ABBYY FlexiCapture in silent mode
msiexec /x {FC90000C-0001-0000-0000-074957833700}

Using Active Directory
Microsoft© Windows© 2000 Server and Microsoft© Windows© 2003 Server include an integrated directory service, Active Directory, which in turn includes Group Policy. The Software Installation snap-in, which is part of Group Policy, allows you to install a software application on several workstations simultaneously.
Three major installation methods are implemented in Active Directory: Publish to User, Assign to User, and Assign to Computer. ABBYY FlexiCapture 9.0 can be installed using the Assign to Computer method. ABBYY FlexiCapture 9.0 will be installed on the specified workstation after the workstation is restarted.

The Publish to User and Assign to User methods are not supported.

When deploying ABBYY FlexiCapture 9.0 using Active Directory®, the account of the computers in the Domain Computers domain must have read right to the administrative installation folder.

**Example: Deploying ABBYY FlexiCapture 9.0 using Active Directory**

The program is installed on one domain computer or on a group of domain computers:

1. During Server Installation, install the Station Installer. If you did not install the Station Installer when installing the Application Server, install the Station Installer by selecting **Control PanelÆAdd or Remove ProgramsÆChange**.

2. Select **StartÆControl PanelÆAdministrative** and then select the Active Directory Users and Computers item.

3. Right-click the site, domain, or another organized unit that contains the computer or group of computers onto which ABBYY FlexiCapture 9.0 is to be installed.
4. On the shortcut menu, select **Properties** and click the **Group Policy** tab.

5. Click **New**, enter a descriptive name, and click **OK**.

6. Right-click the Group Policy Object you have created and select **Edit...**


8. On the shortcut menu, select **New/Packet**.
9. Provide the path to the file ABBYY FlexiCapture 9.0 Stations.msi, which is located in the administrative installation folder on the server.

10. Select the Advanced deployment method.

11. In the dialog box that opens, click the Modifications tab and then click the Add button.
12. Select the interface language to be used in ABBYY FlexiCapture 9.0. The language files are located in the administrative installation folder on the server.

The list of available files and their corresponding languages:

- 1033.mst English
- 1049.mst Russian

Using SMS

Microsoft Systems Management Server automates software deployment and eliminates the need to go directly to the locations where the software is to be installed (computers, groups, or servers).

SMS deployment includes the following three stages:

1. Creating an ABBYY FlexiCapture 9.0 deployment package.
2. Creating a deployment script (contains installation parameters: names of computers, time of installation, conditions for installation, etc.).
3. Deployment of the program on the workstations by SMS based on the script settings.

Example: Deploying ABBYY FlexiCapture 9.0 using Microsoft SMS

1. When installing the Application Server, create an installation package for ABBYY FlexiCapture 9.0 stations.
2. In the SMS Administrator console, select the Packages node.
3. In the Action menu, select New/Package.
4. In the Package Properties dialog box, fill out the required fields.
5. Click the Data Source tab.
6. Make sure that This package contains source files is cleared and click OK.
7. Expand the node of the newly created package and select Programs.
8. In the Action menu, select New/Program.
9. In the Program Properties dialog box, click the General tab and on this tab:
   In the Name field, type a descriptive name of the program
   In the Command Line field, type setup.exe /q
   In the Start in field, provide the network path to the ABBYY FlexiCapture administrative installation folder (e.g. \\MyFileServer\Programs Distribs\ABBYY FlexiCapture 9.0).
10. In the Program Properties dialog box, click the Environment tab and on this tab:
    Clear the User input required option
    Select the Runs with administrative rights option
    Make sure that the Run with UNC name option is selected
11. Adjust the running parameters if required and click OK.
12. You can also use the Distribute Software Wizard. In the Action menu of the package, select Distributive Software and follow the instructions of the wizard.
Important! You cannot create Distribution Points.

Installing a Remote Stations

If the workstation of the Scanning or Data Verification Operator is not part of the LAN, a regular stations will not be able to connect to the Protection Server.

Use Remote Stations in this case. Remote Stations can connect to the Application Server via HTTP.

To install a Remote Stations:

1. Insert the ABBYY FlexiCapture 9.0 CD-ROM into the CD-ROM drive. The setup program will start automatically.
2. Select Distributed Installation.
3. Select Install Remote Scanning Station or Install Remote Data Verification Station.
4. Select a setup language. The setup program will compare the locale of your system and the selected language. If the languages are incompatible, a warning message is displayed.
5. Next, the setup program checks the version of your operating system and the availability of the administrative permissions. If the version of the operating system is not supported by the program or you do not have the administrative permissions, a warning message is displayed and the setup program is terminated.
6. If all the checks are passed successfully, the end-user license agreement will be displayed. Read the license agreement carefully and if you agree with the terms of the agreement, select the corresponding option and click Next.
7. A dialog box will open prompting you to enter some information about yourself. Enter the required information and continue with the installation.
8. Next, select a destination folder. By default, the program is installed to: %\Program Files%\ABBYY FlexiCapture 9.0 Scanning Station\ or %\Program Files%\ABBYY FlexiCapture 9.0 Data Verification Station\. If there is not enough space on the selected hard disk, a window is displayed showing your hard disks, the available free space, and the space required by the installation. Select a disk with sufficient free space and continue with the installation.
9. The program files will be copied onto your computer. Once the installation is finished, the setup program will display a message saying that the installation has completed successfully.

IMPORTANT! The Application Server should be published to the Internet if you wish to use the remote stations over the Internet.
Managing Your Licenses

After you install the program, you need to activate your serial number. This section describes the use of ABBYY FlexiCapture 9.0 License Manager, the license management utility supplied with ABBYY FlexiCapture 9.0.

Overview

**ABBYY FlexiCapture 9.0 License Manager** is a license management utility. It is installed on the Protection Server when the server are installed.

The License Manager allows you to:

- add new licenses
- activate licenses
- view license parameters
- select and enable licenses

Hardware licenses are activated in the same way as software licenses.

**ABBYY FlexiCapture 9.0 License Manager**

The main License Manager window contains the following columns:

- **Serial number** – displays the serial number of the license
- **License parameters** – displays the parameters of the license
License properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial number</td>
<td>Unique license number.</td>
</tr>
<tr>
<td><strong>License parameters</strong></td>
<td></td>
</tr>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td>Serial number</td>
<td>DVPN-9010-0000-4642-4562-3657</td>
</tr>
<tr>
<td>Protection type</td>
<td>software</td>
</tr>
<tr>
<td>Working on virtual machine</td>
<td>yes</td>
</tr>
<tr>
<td><strong>License purpose</strong></td>
<td></td>
</tr>
<tr>
<td>License type</td>
<td>trial</td>
</tr>
<tr>
<td>Business process outsourcing service (BPO)</td>
<td>no</td>
</tr>
<tr>
<td><strong>Work stations</strong></td>
<td></td>
</tr>
<tr>
<td>Station types for Distributed</td>
<td></td>
</tr>
<tr>
<td>Scanning stations</td>
<td>total: 5 free: 5</td>
</tr>
<tr>
<td>Verification stations</td>
<td>total: 5 free: 5</td>
</tr>
<tr>
<td>Setup stations</td>
<td>total: 5 free: 5</td>
</tr>
<tr>
<td>Data verification stations</td>
<td>total: 5 free: 5</td>
</tr>
<tr>
<td>Processing stations</td>
<td>unlimited</td>
</tr>
<tr>
<td>Monitoring stations</td>
<td>unlimited</td>
</tr>
<tr>
<td><strong>Tools</strong></td>
<td></td>
</tr>
<tr>
<td>FlexiLayout Studio</td>
<td>total: 1 free: 1</td>
</tr>
<tr>
<td>FormDesigner</td>
<td>total: 1 free: 1</td>
</tr>
<tr>
<td><strong>Performance</strong></td>
<td></td>
</tr>
<tr>
<td>Page limit</td>
<td>90000</td>
</tr>
<tr>
<td>Available every</td>
<td>79931</td>
</tr>
<tr>
<td>CPU cores</td>
<td>unlimited</td>
</tr>
<tr>
<td>Processing</td>
<td></td>
</tr>
<tr>
<td>FlexiLayouts</td>
<td>yes</td>
</tr>
<tr>
<td>Number of fields</td>
<td>unlimited</td>
</tr>
<tr>
<td>Languages (OCR)</td>
<td></td>
</tr>
<tr>
<td>Chinese</td>
<td>yes</td>
</tr>
<tr>
<td>Korean</td>
<td>yes</td>
</tr>
<tr>
<td>Japanese</td>
<td>yes</td>
</tr>
<tr>
<td>Thai</td>
<td>yes</td>
</tr>
<tr>
<td>Vietnamese</td>
<td>yes</td>
</tr>
<tr>
<td><strong>Custom components (including document definitions)</strong></td>
<td></td>
</tr>
<tr>
<td>Use of components created by users</td>
<td></td>
</tr>
<tr>
<td><strong>Import</strong></td>
<td></td>
</tr>
<tr>
<td>Additional import capabilities</td>
<td></td>
</tr>
</tbody>
</table>

© 2009 ABBYY. All rights reserved.
Export – additional document and image export capabilities

To view all the available licenses, click Choose… or select License ➤ Show all licenses… to open the Licenses window (if no licenses are available, an Add license… button is displayed instead of the Choose… button):

License statuses

Activated (the license had been activated)
Expired (the license had expired or the page limit has been reached)
The current (i.e. active) license has a ✓ next to it and is highlighted in bold.

Buttons in the License window

Hide parameters << (License parameters>>) – hides (shows) the detailed information about the selected license
Activate… - launches the ABBYY FlexiCapture Activation Wizard
Activating a license

ABBYY takes steps to protect its intellectual property from piracy. Software piracy is harmful both to manufacturers and to end users alike. Unlike legally purchased software products, pirated software is never safe and secure.

If your end-user license agreement allows you to install and use the product only one computer, installing it on several computers will breach the agreement and violate the copyright laws of the Russian Federation. The activation technology restricts the number of software copies that can be used simultaneously and thus prevents the installation of one licensed copy on an unlimited number of computers. At the same time, one licensed copy may be installed and activated on one and the same computer any number of times without any restrictions.

You will not be able to use the software product unless you activate it.

How activation is carried out?

The activation process takes very little time and is carried out via an activation wizard. The activation wizard helps you to send the data required for activation to ABBYY. These activation data are sent to ABBYY in the form of a code (Product ID) which is generated based on the hardware on which the product is installed. **No personal data are used** to generate the code and the user remains completely anonymous.
The following activation methods are available:

**via Internet** - activation is carried out automatically and takes several seconds to complete; this method requires an active Internet connection

**by e-mail** - an e-mail message is generated that contains the data required for activation; please do not alter the body or the subject of the message to ensure a prompt reply from the mail robot

**by e-mail from another computer** - an e-mail message is generated that contains the data required for activation; you can use this method if the Protection Server is not connected to the Internet and e-mail messages cannot be sent from it

**load activation file** - connect an activation file you received by e-mail in response to an activation request

Once the activation is complete, **ABBYY FlexiCapture 9.0** can be used on the server on which it was activated.

You can re-install ABBYY FlexiCapture 9.0 as many times as you need without additional activations (provided the Protection Server is not re-installed).

**Note:**

1. **ABBYY FlexiCapture** stations automatically connect to the Protection Server and use the installed license.

2. If you re-install the Protection Server on a different computer, you will need to re-activate your licenses (in the case of a license file) and change the address of the Protection Server in the Protection.ini file on the stations (see the "Connecting stations to the Protection Server" section for details).

3. If there are no free activated licenses available on the Protection Server and a user tries to run the program on their workstation, the program will not start and a warning message will be displayed.

4. Hardware licenses can only be activated over the Internet.

**Connecting stations to the Protection Server**

All the stations installed in the system access the Protection Server. The address of the Protection Server is stored in the Protection.ini file, which can be found here:

- Windows XP:
  ```
  %\Documents and Settings\All Users\Application Data\ABBYY\FlexiCapture\9.0\Licenses
  ```
- Windows Vista:
  ```
  %\ProgramData\ABBYY\FlexiCapture\9.0\Licenses\Protection.ini
  ```

The address of the server is specified in this line:

```
ServerName=old_server
```

To enable a station to access a new Protection Server, simply change the old name to the name of the computer where the Protection Server is installed.
The same applies to the standalone version of ABBYY FlexiCapture 9.0. If you have one license and several operator stations, specify the address of the computer where the license is stored in the Protection.ini files on the workstations.

The Scanning Station and the Data Verification Station get licenses from the Application Server. The Processing Server connected to the Application Server must be running for you to get a license.
Setting Up FlexiCapture 9.0 Distributed Installation

Setting up the system
Once the license is installed and activated, you should set up the system:

1. Open the Administration and Monitoring Console. Create a database. To use a file storage folder, select the corresponding option and provide the path to the folder. This should be a local folder on the Application Server.

   **Note:** If no file storage folder is used, all project files are stored in the database. In terms of efficiency and security, the two approaches are equal. Storing the project files in the databases makes backing up and restoring data easier but increases the size of the database, which may be crucial if you use Microsoft SQL Server Express Edition, as it limits the size of the database to 4 GB.

2. Upload your project to the Application Server by starting the Project Setup Station and doing the following:

3. Create a new project (*File* → *New Project*...). Create or import at least one document definition (*Project* → *Document Definitions*).

4. Open one of the samples (available at `<disk>:\Documents and Settings\All Users\Application Data\ABBYY\FlexiCapture\9.0\Samples`, for Microsoft Windows Vista - `<disk>:\Users\Public\ABBYY\FlexiCapture\9.0\Samples`).

5. Open a project you created in ABBYY FlexiCapture 8.0 Professional.

6. Open a new project and import a batch you created in FormReader 6.5 DE or EE. For the correct operation, the project should contain at least one correct and connected document definition for which export settings have been specified.

   Next, upload the project to the Application Server (*File* → *Upload Project to Server*...).

7. In the Administration and Monitoring Console, select *Settings* → *Users and Groups*. In the *Project* list, select the name of the created project.
Note: The user that created the database had the administrator rights and may start any stations and perform any types of operations. You cannot divest the creator of the database of their administrator rights.

8. To add a user, type their name in the Add field and click User.

9. To change a user’s access rights, find the user in the list and click on the corresponding link. Specify the roles of the user. For the Data Verification Operator, Verification Operator, Senior Verification Operator, and Scanning Operator roles, you must also specify the batch types accessible to the user. The other roles may access all batch types.

10. If required, create user groups and grant them the necessary access rights. Using groups saves time and makes user management easier.

Note: The Administrator, Monitoring Operator, and Processing Server roles can be assigned without creating a project in the database. The other roles require access rights to specific projects, therefore you need to create at least one project before you can assign those roles.

Important! The account of the computer on which the Processing Server runs must be added to the list of users with the Processing Server role. If this computer is part of a domain, the account will look like this: \Domain Name\Computer Name\$ (e.g. Fine\quad-1\$). Subsequently, the Processing Server will automatically control the Processing Stations, their access rights, etc.

11. Start the Processing Server Monitor (Start ➔ ABBYY FlexiCapture 9.0 Servers ➔ Processing Server) and set up the server:

12. Select Actions ➔ Properties and specify the address of the Application Server (e.g. http://ApplicationServer).

13. Start the Processing Server by clicking .

14. Add Processing Stations by selecting Stations in the tree and clicking . Add the names of the stations or locate them in the LAN:
Then select the stations in the list displayed in the main window of the Processing Server Monitor and click.

15. If Hot Folders are to be used for image import in any of the projects, connect these folders in the node of the same name.

16. If required, specify the general project processing options on the Project Setup Station ("Default" batches, Project→Project Properties..., Workflow tab). If several batch types are used, specify the processing parameters for each batch type: select Project→Batch Types..., select the desired type, click Edit... and then click the Workflow tab.

Setting up Microsoft Internet Information Server (IIS)

The Application Server can only be installed on a computer on which Microsoft Internet Information Server 5.1, 6 or 7 is installed. IIS is required for the correct operation of the Application Server and the Administration and Monitoring Console.

Checking the operation of IIS

To check the operation of IIS, start it by selecting Start→Control Panel→Administrative Tools→Internet Information Services. If a problem occurs when starting IIS, the following message will be displayed: "Unexpected error 0x8ffe2740 occurred" for v. 5.1 (Windows XP) or "The process cannot access the file because it is being used by another process" for v. 6.0 (Windows 2003) and v. 7.0 (Windows 2008).
This error message means that port 80 is in use. To find out which application is using the port, do the following:

1. In the command line (Start→Run), type
netstat -ano | findv "80"
The list of connections to port 80 will be displayed and the ID of the corresponding process in the following format:
TCP  0.0.0.0:80   0.0.0.0:0   LISTENING  1264

2. Type
tasklist /SV /FI "PID eq 1264"
replacing 1264 with the ID of the process obtained at step 1. The result will be displayed in the following format:

<table>
<thead>
<tr>
<th>Image Name</th>
<th>PID</th>
<th>Services</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virus.exe</td>
<td>1264</td>
<td>KillMePlz</td>
</tr>
</tbody>
</table>

3. End the process that uses the port.

**Important!** Do not switch IIS over to another port, as you will not be able to start the Application Server in this case.

### Setting Up IIS

**All IIS versions (5.1, 6.0, 7.0)**

The default site (i.e. the site with the identifier 1) should contain the virtual folder **Default Web Site\FlexiCapture\Server** with the following objects:

- DatabaseManager.dll
- DBInitFillSql
- Description.sql
- FineObj.dll
- FlexiCaptureWebServices.disco
- FObjEventSrc.dll
- msvcr71.dll
- web.config
- WebServices.dll
- WebServices.htm
- WebServicesIsapi.dll

**ABBYY FlexiCapture 9.0 Server** must be associated with this folder. In *Scripts and Executable*, the execute permissions should be set up.

The following mapping should be specified in the application settings: .dll → C:\Inetpub\wwwroot\FlexiCapture\Server\WebServicesIsapi.dll.

For the default mode (i.e. all stations in the domain), anonymous access must be prohibited and integrated windows authentication must be turned on.

Basic authentication must be turned on to enable a login/password-based connection of a Remote Scanning Station.

You can use the HTTPS protocol for greater security. To use HTTPS, enable SSL support in the IIS.

**IIS 6.0 and later**

You must explicitly allow the isapi extension, which corresponds to the server (**FlexiCapture Web Services**→**WebServicesIsapi**).

A separate poll of processes must be created for the application (the recommended number of processes in the pool is three; for IIS 7.0, the pool should be a classic-mode 32-bit pool).

When installing on Windows Server 2003 and Windows Server 2008, the performance may be extremely low. If this is indeed the case, adjust this registry branch as shown below:

```
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\TcpIp\Parameters\Interfaces.
```

Inside each GUID, create **TcpAckFrequency** = 1 of type DWORD.

**IIS 7.0**

For normal error diagnostics, allow detailed errors in all cases (**Server**→**Error Pages**→**Detailed Errors**).

Remove the ISAPI.dll module from the list of allows modules (it is incompatible with our isapi extension).

To make the location of errors easier, consult the following fragment of applicationHost.config (see
<disk>:\Windows\System32\inetsrv\config) obtained after installing IIS 7.0.
<configuration>
  <applicationPools>
    ...
    <add name="FlexiCapture Web Services" managedPipelineMode="Classic">
      <processModel identityType="NetworkService" maxProcesses="3" />
    </add>
  </applicationPools>

  <sites>
    <site name="Default Web Site" id="1" serverAutoStart="true">
      ...
      <application path="/FlexiCapture/Server" applicationPool="FlexiCapture Web Services">
        <virtualDirectory path="/" physical-Path="C:\inetpub\wwwroot\FlexiCapture\Server" />
      </application>
    </site>
  </sites>

  <security>
    <isapiCgiRestriction notListedIsapisAllowed="false" notListedCgisAllowed="false">
      <clear />
      ...<add path="C:\Windows\Microsoft.NET\Framework\v2.0.50727\aspnet_isapi.dll" allowed="true" groupId="ASP.NET v2.0.50727" description="ASP.NET v2.0.50727" />
      <add path="C:\inetpub\wwwroot\FlexiCapture\Server\WebServicesIsapi.dll" allowed="true" groupId="FlexiCaptureWebServices" description="FlexiCapture Web Services" />
    </isapiCgiRestriction>
  </security>

  <location path="Default Web Site/FlexiCapture">
    <system.webServer>
      <directoryBrowse enabled="false" showFlags="None" />
      <handlers accessPolicy="Read, Execute" />
      <httpLogging dontLog="false" />
      <security>
        <authentication>
          <windowsAuthentication enabled="true" />
          <anonymousAuthentication enabled="false" />
          <digestAuthentication enabled="false" />
          <basicAuthentication enabled="false" />
        </authentication>
      </security>
      <defaultDocument enabled="true">
        <files>
          <add value="DefaultPage.aspx" />
        </files>
      </defaultDocument>
      <httpErrors>
        <clear />
        <httpErrors>
          <asp>
            <session timeout="00:20:00" />
            <limits scriptTimeout="00:01:30" />
          </asp>
        </httpErrors>
      </httpErrors>
    </system.webServer>
  </location>
</configuration>
<system.webServer>
  <directoryBrowse enabled="false" showFlags="None" />
  <handlers accessPolicy="Read, Execute">
    <clear />
    <add name="rules-Integrated" path="*.rules" verb="*" type="System.ServiceModel.Activation.HttpHandler, System.ServiceModel, Version=3.0.0.0, Culture=neutral, PublicKeyToken=b77a5c56193e089" preCondition="integratedMode" />
    <add name="xml-Integrated" path="*.xml" verb="*" type="System.ServiceModel.Activation.HttpHandler, System.ServiceModel, Version=3.0.0.0, Culture=neutral, PublicKeyToken=b77a5c56193e089" preCondition="integratedMode" />
    <add name="svc-Integrated" path="*.svc" verb="*" type="System.ServiceModel.Activation.HttpHandler, System.ServiceModel, Version=3.0.0.0, Culture=neutral, PublicKeyToken=b77a5c56193e089" preCondition="integratedMode" />
    <add name="ISAPI-dll" path="*.dll" verb="*" modules="IsapiModule" resourceType="File" requireAccess="Execute" allowPathInfo="true" />
    <add name="TraceHandler-Integrated" path="trace.axd" verb="GET,HEAD,POST,DEBUG" type="System.Web.Handlers.TraceHandler" preCondition="integratedMode" />
    <add name="PageHandlerFactory-Integrated" path="*.aspx" verb="GET,HEAD,POST,DEBUG" type="System.Web.UI.PageHandlerFactory" preCondition="integratedMode" />
    <add name="SimpleHandlerFactory-Integrated" path="*.ashx" verb="GET,HEAD,POST,DEBUG" type="System.Web.UI.SimpleHandlerFactory" preCondition="integratedMode" />
    <add name="rules-ISAPI-2.0" path="*.rules" verb="*" modules="IsapiModule" scriptProcessor="C:\Windows\Microsoft.NET\Framework\v2.0.50727\aspnet_isapi.dll" preCondition="classicMode, runtimeVersionv2.0, bitness32" />
    <add name="xml-ISAPI-2.0" path="*.xml" verb="*" modules="IsapiModule" scriptProcessor="C:\Windows\Microsoft.NET\Framework\v2.0.50727\aspnet_isapi.dll" preCondition="classicMode, runtimeVersionv2.0, bitness32" />
    <add name="svc-ISAPI-2.0" path="*.svc" verb="*" modules="IsapiModule" scriptProcessor="%windir%\Microsoft.NET\Framework\v2.0.50727\aspnet_isapi.dll" preCondition="classicMode, runtimeVersionv2.0, bitness32" />
    <add name="AXD-ISAPI-2.0" path="*.axd" verb="GET,HEAD,POST,DEBUG" modules="IsapiModule" scriptProcessor="%windir%\Microsoft.NET\Framework\v2.0.50727\aspnet_isapi.dll" requireAccess="Script" preCondition="classicMode, runtimeVersionv2.0, bitness32" responseBufferLimit="0" />
    <add name="PageHandlerFactory-IsAPI-2.0" path="*.aspx" verb="GET,HEAD,POST,DEBUG" modules="IsapiModule" scriptProcessor="%windir%\Microsoft.NET\Framework\v2.0.50727\aspnet_isapi.dll" requireAccess="Script" preCondition="classicMode, runtimeVersionv2.0, bitness32" responseBufferLimit="0" />
    <add name="SimpleHandlerFactory-IsAPI-2.0" path="*.ashx" verb="GET,HEAD,POST,DEBUG" modules="IsapiModule" scriptProcessor="%windir%\Microsoft.NET\Framework\v2.0.50727\aspnet_isapi.dll" requireAccess="Script" preCondition="classicMode, runtimeVersionv2.0, bitness32" responseBufferLimit="0" />
    <add name="WebServiceHandlerFactory-ISAPI-2.0" path="*.asmx" verb="GET,HEAD,POST,DEBUG" modules="IsapiModule" scriptProcessor="%windir%\Microsoft.NET\Framework\v2.0.50727\aspnet_isapi.dll" requireAccess="Script" preCondition="classicMode, runtimeVersionv2.0, bitness32" responseBufferLimit="0" />
    <add name="HttpRemotingHandlerFactory-rem-ISAPI-2.0" path="*.rem" verb="GET,HEAD,POST,DEBUG" modules="IsapiModule" scriptProcessor="%windir%\Microsoft.NET\Framework\v2.0.50727\aspnet_isapi.dll" requireAccess="Script" preCondition="classicMode, runtimeVersionv2.0, bitness32" responseBufferLimit="0" />
    <add name="HttpRemotingHandlerFactory-soap-ISAPI-2.0" path="*.soap" verb="GET,HEAD,POST,DEBUG" modules="IsapiModule" scriptProcessor="%windir%\Microsoft.NET\Framework\v2.0.50727\aspnet_isapi.dll" requireAccess="Script" preCondition="classicMode, runtimeVersionv2.0, bitness32" responseBufferLimit="0" />
  </handlers>
</system.webServer>
Security settings

Major scenario

Conditions:
All participants (computers and users) are in a domain.

Features:
Requires minimum additional settings.

Actions:
1. After the system is installed, the administrator of the computer on which the Application Server is installed creates a database using the Administration and Monitoring Console and gets the system administrator role. The administrator has full access rights including the right to change the settings of the Application Server, upload projects to the Application Server, create user accounts and user groups and configure their roles and access rights.

2. The administrator may assign the administrator role to another user on the Users page of the Administration and Monitoring Console. Thereby the administration of the system will be delegated to that user.

3. The administrator of the system assigns the role of the Processing Server to the user account under which the Processing Server service runs. By default the service runs under the Network Service account, which is represented in the Administration and Monitoring Console in the format <Domain Name>\<Computer name>. If required, the Processing Server service can run under another user account, in this case the role of the Processing Server must be assigned to that user. If the
4. The administrator uploads the projects and assigns roles to the operators.
5. The administrator starts the Processing Server using the Processing Server Monitor and adds Processing Stations. Access rights are granted to the Processing Stations automatically.

**Some of the stations are not in the domain**

**Conditions:**
- Scanning Station and Data Verification Stations operate remotely (they are not in the same domain as the computer on which the Application Server is installed).
- To connect remote stations with the Application Server, the NTLM pass-through authentication can be used. General principle: to enable a user of computer M2 who works under the local account M2/User[password] to authorize on computer M1, you must duplicate this account (with the same password) on the M1 computer, that is to create M1/User[password].
- To connect remote stations with the Application Server, you can also use basic authentication, which requires explicitly specifying accounts on the remote stations.
- All other stations and servers must be in the same domain as the Application Server.

**Actions:**
1. Do the steps of the major scenario above.
2. On the Application Server, create local accounts corresponding to the remote users. Further, there are two possible variants which can be used both separately and together (see step 3 and 4).
3. On the remote stations, create identical accounts (same names and passwords) as in step 2, and run the stations under these accounts.
4. In IIS on the computer on which the Application Server is installed, turn on the basic authentication at the level of the Flexi-Capture/Server site. Afterward, when starting the remote stations (when starting the Scanning Station and when opening a project at the Data Verification Station), you must explicitly specify the account from the step 2.

**Work group**

**Conditions:**
The stations and the servers are in a work group.

**Features:**
- To connect clients (the stations and the Processing Server) with the Application Server, the NTLM pass-through authentication must be used. General principle: to enable user of computer M2 (account M2/User[password]) to authorize on computer M1, you must duplicate this account (with the same password) on computer M1, that is create M1/User[password].
- To connect remote stations with the Application Server, you can also use basic authentication, which requires explicitly specifying accounts on the remote stations.

**Actions:**
1. If you are going to create the database on the SQL server which in not installed on the same computer as the Application Server, you must enable the user under whose account the Application Server runs to authorize on the computer on which the SQL server is installed. For this, the pass-through authentication must be used: on the computer on which the Application Server is installed, create a user account, run Application Pool FlexiCapture Web Services (see the Identity property of the application pool) and FlexiCapture Monitoring under this user account and create the same user account (same name and password) on the computer on which SQL server is installed.
2. Perform steps 1, 2 of the major scenario above.
3. On the computer on which the Application Server is installed, create local accounts for the Processing Server, Processing Station and all operators.
4. On the computer on which the Processing Server is installed, create a local account for it. By using services.msc start the ABBYY FlexiCapture Processing Server service under this account. Afterward, in the Processing Server Monitor, try to start the Processing Server. If a message concerning the HTTP 401 error appears, it means that the user for the Processing Server service is specified incorrectly (it is different from the user created on the computer on which the Processing Server is installed). If the message “Access is denied. Contact the system administrator” appears, it means that authentication in IIS has been successful.
5. By using the Administration and Monitoring Console assign a role to the Processing Server account (created in step 3).

6. If Processing Stations operate on separate computers, then, similar to step 4, on all stations, create local accounts and start the ABBYY FlexiCapture Processing Server service under these accounts. If the HTTP 401 error occurs, the user account is specified incorrectly (it does not correspond to the user created on the computer on which the Processing Server is installed). If the settings are correct, the Processing Station will run.

7. On user stations (Project Settings Station, Verification Station, Data Verification Station, Scanning Station), create local accounts, corresponding to the accounts on the computer on which the Application Server is installed, grant access rights to these users by using the Administration and Monitoring Console and start the stations under these accounts.

8. To start the remote Scanning Stations and Data Verification Stations, basic authentication can be used. See how to configure the basic authentication, in the section “Some of the stations are not in the domain”.

**Without authorization**

**Conditions:**
- Connection between the servers and the stations has been established.

**Features:**
- No authorization. As a result, it is not possible to configure different access rights for different operators. All users will have the same set of roles and access rights granted to the anonymous user.

**Actions:**
1. Perform steps 1 of the Work Group scenario for connecting the database to the server (if the database is not located on the same computer as the Application Server).
2. Create a database and explicitly specify the user’s login name and password.
3. On the computer on which the Application Server is installed, allow anonymous login in the IIS settings. In the Administration and Monitoring Console, assign all the roles (or the administrator role) to the anonymous account (of type IUSR_XXX) specified in IIS.

**Database settings**

Prior to creating a database in Oracle, do the following actions:

1. On the computer on which the Application Server is installed, install the Oracle client for Windows 32bit (even though Windows x64 is installed) and Oracle DBMS for this OS. The Application Server does not work with the Oracle client for Windows x64.
2. In Oracle DBMS create a user, e.g. FCUSER, and assign the CONNECT and DBA roles to this user. One FlexiCapture database corresponds to one user. If several FlexiCapture databases running under Oracle DBMS are required, create a user for each database.
3. Establish the connection between the client and the Oracle server using the Net Manager utility, which is installed together with the Oracle client (in the Administration configuration) and the database server. In the client utility, create a new Service Naming element (a local naming method), which must be connected with the Oracle database server by its SID. Test the connection with the database server on behalf of the user account created in step 2. Go to the next step only if the connection test succeeds. If you cannot set up the connection, consult the Oracle documentation.
4. When creating the database in the Administration and Monitoring Console, specify the name of the Service Naming element created in step 3.

After you create the database using the Administration and Monitoring Console you should note that by default, an Oracle database allows a maximum of 40 processes and 49 sessions. When these limits are reached, errors will occur. If required, increase the default values by using a script similar to the following:

```sql
connect sys/<Login> as sysdba;
alter system set sessions=<SessionCount> scope=spfile;
alter system set processes=<ProcessCount> scope=spfile;
shutdown immediate;
startup;
```
Logging

Administration and Monitoring Console logs
The event and error logs available in the Administration and Monitoring Console are the main logs that register errors that occur in the system in general. These logs record all errors that occur during document processing and affecting the processing and all events that occur during document processing. To view the logs, select MonitoringÆEvent Log and MonitoringÆError Log in the Administration and Monitoring Console.

Task processing logs on the Processing Servers
The Processing Server logs the processing of the tasks. The list of the active tasks and their logs can be accessed via the Processing Server Monitor. To view a task log, select ActionsÆView Log... when selecting the task.

OS event logs on the servers
The server components (Application Server, Processing Server, and Processing Stations) log errors and warnings in the local event log of the operating system under which they are running (section: Application, sources: FlexiCapture Web Services and FlexiCapture Processing Server). These logs can be accessed by the administrators both locally and remotely via the standard Event Viewer tool of the MMC console.

The local OS event log records not only processing errors, but also all errors in the operation of the server components not directly related to the processing of documents. This log will list processing errors even if the Application Server is inaccessible at the time of error and the error cannot be logged in the ABBYY FlexiCapture log.
Technical Support

Should you have any questions regarding the installation and use of ABBYY FlexiCapture 9.0, please contact the ABBYY technical support service or the technical support service of the ABBYY partner from which you obtained the software. For contact details, see the Technical Support section of the ABBYY website at www.abbyy.com.